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Package Contents

Contents of Package:

D-Link Air Premier AG DI-784 11a/11g Wireless 108Mbps
Router

Power Adapter — 5V DC, 3.0A
Manual on CD

Quick Installation Guide
Ethernet Cable

Note: Using a power supply with a different voltage rating than the one included with the
DI-784 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements For Configuration:

m Computer with Windows, Macintosh, or Linux-based
operating system with an installed Ethernet adapter



Introduction

At up to fifteen times the speed of previous wireless devices, you can work faster and
more efficiently, increasing productivity. With the DI-784, bandwidth-intensive applications
like graphics or multimedia will benefit significantly because large files are able to move
across the network quickly. This versatile wireless router also features four times the
number of non-overlapping channels than a device that supports only 802.11g, so more
users can access the network.

Support for all three standards (802.11g; 802.11a; 802.11b) means that you can grow

your network without having to worry about legacy wireless equipment being incompatible
with newer compliant devices from other manufacturers. This also allows network
administrators to partition the usage of the dualband by segmenting users and creating
special access privilege networks for classified document transfer and communications.

With the DI-784 you can securely connect to wireless clients on the network using
802.1x for wireless user authentication, as well as WPA (Wi-Fi Protected Access™)
providing you a much higher level of security for your data and communications than
has previously been available.

Through its easy-to-use Web-based user interface, the DI-784 lets you control the
information that is accessible to those on the wireless network, whether from the Internet
or from your company’s server:

Content Filtering — Easily applied content filtering based on MAC Address, IP Address,
URL and /or Domain Name.

Filter Scheduling — Filters can be scheduled to be active on certain days or for a
duration of hours or minutes.

Network Address Translation — NAT protects the DI-784 and its users from outside
intruders gaining access to your private network

VPN Multiple/Concurrent Sessions — Supports multiple and concurrent IPSec and
PPTP sessions, so multiple users behind the DI-784 can access corporate networks
through various VPN clients more securely.



Connections - Back Panel of Unit

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you can
use either a straight-through or a
crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX
LAN ports
automatically
sense the cable
type when
connecting to
Ethernet-enabled
computers.

The Auto MDI/MDIX Receptor
WAN portis the for the
connection for the Power
Ethernet cable to Adapter
the Cable or DSL

modem




Features

Fully compatible with the 802.11a and 802.11g standards to provide a wire-
less data rate of up to 54Mbps

Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

WPA (Wi Fi Protected Access ™) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring greater
security

M Pre-Shared Key mode means that the home user, without a RADIUS
server, can connect securely via a pre-shared key, vastly improving the
safety of communications on the network.

802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing) to
ensure strong wireless signals for both 802.11g and 802.11a

User-friendly configuration and diagnostic utilities
Operates in the 2.4GHz and 5GHz frequency ranges

Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection

Advanced Firewall features
B Supports NAT with VPN pass-through, providing added security
B MAC Filtering
M |P Filtering
B URL Filtering

B Domain Blocking
W Scheduling

DHCP server supported enables all networked computers to automatically
receive IP addresses

Web-based interface for Managing and Configuring

Access Control to manage users on the network

Supports special applications that require multiple connections

Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX 6



Power

A solid light
indicates a proper
connection to the

LEDs - Front Panel of Unit

LED stands for Light-Emitting Diode. The DI-784 has the following LEDs:

power supply.

Status

A blinking light
indicates that the
DI-784 is ready.

D-Linl

WAN LED
A solid light
indicates connec-
tion on the WAN
port. This LED
blinks during data
transmission.

WLAN LEDs for 11g
and 11a wireless net-
work segments.

A solid light indi-
cates that the
wireless segment is
ready. The LEDs
blink during wireless

data transmission.

Local

Network LEDs

A solid light indicates
a connection to an
Ethernet-enabled
computer on ports 1-
4. The LEDs blink
during data transmis-
sion.




Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless networking
brings.

A WLAN is a cellular computer network that transmits and receives data with radio
signals instead of wires. WLANs are used increasingly in both home and office
environments, and public areas such as airports, coffee shops and universities. Innovative
ways to utilize WLAN technology are helping people to work and communicate more
efficiently. Increased mobility and the absence of cabling and other fixed infrastructure
have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANs are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANSs can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast
and easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home or
office.

Scalability — WLANs can be configured in a variety of topologies to meet the needs of
specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number
of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology

The DI-784 Wireless Broadband Router utilizes the new 802.11g standard, in addition
to the 802.11a and 802.11b standards.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the
data rate up to 54 Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

Installation Considerations

The D-Link Air Premier AG DI-784 lets you access your network, using a wireless
connection, from virtually anywhere within its operating range. Keep in mind, however,
that the number, thickness and location of walls, ceilings, or other objects that the
wireless signals must pass through, may limit the range. Typical ranges vary depending
on the types of materials and background RF (radio frequency) noise in your home or

business. The key to maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the DI-784 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

9



Getting Started

Internet

¥ Cable/DSL Modem

DI-784

11a/11g Dualband
Wireless 108Mbps Router

Computer 3
Desktop PC or Laptop

(Wireless Adapter Required)

Computer 1

Desktop PC or Laptop

p Computer 2

Desktop PC or Laptop

(Wireless Adapter Required)

For a typical wireless setup at home (as shown above),
please do the following:

o You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office)

9 Consult with your Cable or DSL provider for proper installation of the modem

Connect the Cable or DSL modem to the DI-784 Wireless Router (see the
printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link Air
4 Premier AG DWL-AG530 wireless PCl adapter into an available PCI slot on your
desktop computer.

(See the printed Quick Installation Guide included with the network adapter.)

Install the D-Link DWL-AG650S wireless Cardbus adapter into a laptop com-
puter. (See the printed Quick Installation Guide included with the DWL-AG660.)

=y, Install the D-Link DFE-530TX+ wireless Cardbus adapter into a desktop com-
6 puter. The four Ethernet LAN ports of the DI-784 are Auto MDI/MDIX and will
work with both Straight-through and Crossover cable.
(See the printed Quick Installation Guide included with the DFE-530TX+.) 10



Using the Configuration Menu

Whenever you want to configure your network or the DI-784, you can access the
Configuration Menu by opening the web-browser and typing in the IP Address of the

DI-784. The DI-784 default IP Address is shown here:

Open the web browser
Type in the IP Address of
the Router (http://192.168.0.1)

File Edit View Favorites Tools  Help

Qo - O HRAD |

address €] http://192.168.0.1

Note: if you have changed the default IP Address
assigned to the DI-784, make sure to enter the

correct IP Address.

[ Type admin in the User prres
Name field }ﬁ }
Password:
[ Leave the Password nemenber my passuord
blank
] Click OK

The Home>Wizard screen will appear.
Please refer to the Quick Installation T home v
Guide for more information regarding the i

Setup Wizard.

These buttons appear
on most of the configu-
ration screens in this
section. Please click on
the appropriate button
at the bottom of each
screen after you have
made a configuration
change.

Connect to 192.168.0.1

A

%

Home > Wizard

Aff‘pr'E'I‘l‘liEI"!\(-"
Ay

11a/11g Dualband Wireless 108Mbps Reuter

Status Help

The DF784 bu @ Tol-Mode Dualband Wisslwss Rautes ideal for hame netwedking

» guide you o conbiguin the
DHTBA 1o commect 1o yust 1S9 (nfsimet Service Pravider). The DRTH's aasy sanip
will allaw you 1o saiup
wizand step by stvp ts conflgure e

- [[Fanviea |

WA
r—
LAN
pr—

DHCP

=

a Clicking Apply will save changes made to the page
Apply

3;3 Clicking Cancel will clear changes made to the page
Cancel

o Clicking Help will bring up helpful information regarding the page
Help

@ Clicking Restart will restart the router. (Necessary for some changes.)
Restart

11



Using the Configuration Menu (continued)

Home > Wireless > Open or Shared

D-Link Air Pr'emierA(ww
)}

Building Networks for People

11a/11g Dualband Wireless 108Mbps Router

DI1-784

[T - Advanced  Tools Status Help

Wireless Settings  © 80211y @ 80211a
These are the wireless settings for the AP(Access Point)Portion.

SEID |default

Channel | 52 o |
Turbo Made © on @ Off
WEP O Enabled & Disabled

WEP Encryption | 152Bit +
Key Type | HEX v

Keyl @ |DDDDDDDDDDDDDDDDDDDDDDDDDDDDDD|

Key2 O |DDDDDDDDDDDDDDDDDDDDDDDDDDDDDD|

Keyd O |DDDDDDDDDDDDDDDDDDDDDDDDDDDDDD|

Keyd O |DDDDDDDDDDDDDDDDDDDDDDDDDDDDDD|

9 90

Apply Cancel Help

Wireless Settings-

Choose 802.11a or 802.11g. Here, 802.11a is selected.

802.11a uses the 5GHz frequency range and can support speeds of up to 54Mbps.
802.11g uses the 2.4GHz frequency range and can support speeds of up to 54Mbps.
802.11g is also backwards compatible with 802.11b.

SSID-

“default” is the default setting. All devices on the network must share the same SSID. If
you change the default setting, the SSID may be up to 32 characters long.

12



Using the Configuration Menu (continued)

Home > Wireless > Open or Shared (continued)

Channel- 52 is the default channel for 802.11a.
6 is the default channel for 802.11g.
All devices on the network must share the same channel.

Authentication- Open System - communicates the key across the network

Shared Key - devices must have identical WEP settings in or-
der to communicate in the network

WPA - Wi-Fi Protected Access authorizes and authenticates
users onto the wireless network. WPA uses stronger security
than WEP and is based on a key that changes automatically at
a regular interval. This mode requires a RADIUS server in the
network.

WPA-PSK - Pre-Shared Key mode means that the wireless cli-
ent and the router must have the same passphrase in order to

establish the wireless connection. A RADIUS server is not re-
quired with PSK.

WEP- Select Enabled or Disabled. Disabled is the default setting.

WEP Encryption- Select the level of encryption desired: 64, 128 or 152-bit

All the devices on your network must share the same wireless
settings in order to communicate.

Key Type- Select HEX or ASCII

Hexadecimal digits consist of the numbers 0-9 and the letters A-F
ASCII (American Standard Code for Information Interchange) is a code for repre-
senting English letters as numbers from 0-127

Keys 1-4- Input up to 4 WEP keys; select the one you wish to use.

13



Using the Configuration Menu (continued)
Home > Wireless > WPA

Authentication-

802.1x

Lifetime-

Radius Server 1-

Radius Server 2-

D-Link

- -
Building Networks for People AijrPren |IEI7\G--
11a/11g Dualband Wireless 108Mbps Router
DI-784
| 101 "9 Advanced _ Tools Status Help
‘/’ Wir gs @ 802.11g O 802.11a
These are the wireless settings for the AP{Access Point)Portion.
Wizard
SSID : | default
m i ‘1 "
Authentication : O Open System O Shared Key @ wpa O WPA-PSK
WAN Lifetime |30 Minutes v
RADIUS Server 1 1P 0.0.00
AN Port GE
Shared Secret |
T RADIUS Serier 2 P [oss ]
(Optional) 1
Port 0 |
Shared Secret | ‘
@ OO0
Apply Cancel Help

WPA (Wi-Fi Protected Access) is selected.

Wi-Fi Protected Access authorizes and authenticates users onto
the wireless network. WPA uses stronger security than WEP
and is based on a key that changes automatically at a regular
interval. This mode requires the inclusion of a RADIUS server in
your network.

802.1x Authentication is a first line of defense against intrusion.
In the Authentication process the server verifies the identity of
the client attempting to connect to the network. Unfamiliar cli-
ents are denied access.

Select 5, 15, 30 minutes, or 1 or 8 hours, or 1 day for the authen-
tication period. After this period expires, a new key will auto-
matically be generated.

IP - Enter the IP Address of the RADIUS server.

Port - Enter the port number that your RADIUS server uses for
Authentication. The default setting of 1812 is the port setting for
many RADIUS servers.

Shared Secret - Enter the Shared Secret. The Shared Secret
must be the same as the Shared Secret on your RADIUS server.

Optional. If you have a second RADIUS server, you will
input the same information as shown above. 14



Using the Configuration Menu (continued)

Home > Wireless > WPA-PSK

Building Networks for People

D-Link Air Premier/\Gw

11a/11g Dualband Wireless 108Mbps Router
DI-784

(T I Advanced Tools Status Help |

Wireless Settings @ 802.11g © 802.11a
These are the wireless settings for the AP{Access Point)Portion.

|
‘/.

SSID : |default

Channel :
Wireless Authentication : O Open System O Shared Key O wpa & WPA-PSK
Passphrase : |
[

|
7 9 OO0

Apply Cancel Help

DHCP

i

Authentication- WPA-PSK - Pre-Shared Key mode means that the wireless cli-
ent and the router must have the same passphrase in order to
establish the wireless connection. A RADIUS server is not re-
quired with PSK.

Passphrase- Enter a passphrase for the router. The RADIUS server should
use the same passphrase (secret key) as the router.

15



Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/Secondary
DNS-

MTU-

Home > WAN > Dynamic IP Address

Building Networks for People

D-Link AirPr emier}-\(w;

113/11g Dualband Wireless 108Mbps Router

DI-784
| (1 " Advanced  Tools Status Help
Please select the appropriate option to connect to your ISP,
Wizard
@ Dynamic IP Address Choose this option to obtain an [P address automatically
from your ISP, (For most Cable modem users)
r Wireless O Static IP Address Choose this option to set static IP information provided to
you by your ISP.
© PPPoE Chaoose this option if your ISP uses PPPoE. (For most
DSL users)
WAN O Others PPTP and BigPond Cable
O PPTP (for Europe use only)
LAN
Host Name (D774 | (ontional)
T — — e
DHCP WAL Ailifess oo [-fi1 J-[ez ][5 ]-[44 ][5 ] faptionai
Clone MAC Address
Primary DNS Address [0.0.0.0 ]
Secondary DNS Address |00.0.0 j‘(gp(mnan
WU [1500 |
2 00
Apply Cancel Help

Most Cable modem users will select this option to obtain an IP
Address automatically from their ISP (Internet Service Provider).

This is optional, but may be required by some ISPs. The host
name is the device name of the Router.

The default MAC Address is set to the WAN'’s physical inter-
face MAC address on the Router.

Copy the MAC address of the Ethernet card installed by your ISP,
and replace the WAN MAC address with this Ethernet card MAC
address. Itis not recommended that you change the default MAC
address unless required by your ISP.

Enter a DNS Address if you do not wish to use the one provided
by your ISP. (DNS is short for Domain Name System. It trans-
lates domain names into IP Addresses).

Enter an MTU value only if required by your ISP. Otherwise,
leave this section to its default setting of 1500. (MTU is short
for Maximum Transfer Unit. Messages longer than the MTU

will be divided into smaller units for transmission). 16



Using the Configuration Menu (continued)

Static IP Address-

IP Address-

Subnet Mask-

ISP
Gateway Address-

Primary/
Secondary DNS-

MTU-

Home > WAN > Static IP Address

D-Link

Building Networks for People

Ajr Pr‘emler:,\Gw
11a/11g Dualband Wireless 108Mbps Router

DI-784

Home Advanced Tools Status Help

Please select the appropriate option to connect to your ISP,

Wizard

- 3) Dynamic IP Address Choose this option to obtain an IP address autoratically
frorn your ISP. (For rost Cable modem users)
N GR @ Static IP Address Choose this option to set static IP information provided to
Wireless you by your ISP
) PPPoE Choose this option if your ISP uses PPPoE. (For most
DSL users)
| ‘WAN © Others PPTP and BigPond Cable
O PPTP (for Europe use only)
LAN Static
IP Address 10.0.0.0 (assigned by your ISP}
T DHCP Subnet Mask iED_D 0

ISP Gateway Address |0,0.0.0
Primary DNS Address iEEI_[I i}
Secondary DNS Address | 0.0.0.0 {optional)

MTU 1500 |

9 00O

Apply Cancel Help

Select this option to set static IP information provided to you
by your ISP.

Input the IP Address provided by your ISP

Input your Subnet mask. (All devices in the network must
have the same subnet mask.)

Input the Gateway address

Enter a DNS Address if you do not wish to use the one pro-
vided by your ISP. (DNS is short for Domain Name System. It
translates domain names into IP Addresses).

Enter an MTU value only if required by your ISP. Otherwise,
leave this section to its default setting of 1500. (MTU is short
for Maximum Transfer Unit. Messages longer than the MTU

will be divided into smaller units for transmission). 17



Using the Configuration Menu (continued)

(Please &
be sure

to remove any

existing PPPoE

client software

installed on your
computers.

~\

Home > WAN > PPPoE

D-Link

Building Networks for People

Air Pr-emier}\Gw

11a/11g Dualband Wireless 108Mbps Router

DI-784

Home Advanced Tools Status Help

WAN Setlings

Please select the appropriate option to connect to your ISP

\. J

PPPOE-

User Name-

Password-

r—
© Dynamic IP Address Choose this option to obtain an IP address automatically
from your ISP. (For most Cable modem users)
e O Static IP Address Choose this option to set static 1P information provided to
' Wireless yau by your ISP,
@& PPFoE Chonse this option if your ISP uses PPPoE. (For most
DSL users)
E O Others PPTF and BigPond Cable
) PPTP (for Europe use only)
—

PPPoE

LAN
@ Dynamic PPPoE O Static PPPoE
User Mame It
e |test0]
DHCP ; ‘
Password | }

Retype Password

Sewvice Name | ‘(nptmma\)

IP Address
Primary DNS Address

[oonn (optional)

Secondary DNS Address
Maximurm Idle Time 1] Minutes
MTU [1am2 |

Auto-reconnect @ Enabled O Disabled

9 900

Apply Cancel Help

Choose this option if your ISP uses PPPoE. (Most DSL users
will select this option).

Dynamic PPPoE- receive an IP Address automaticsally from
your ISP.

Static PPPoE- you have an assigned (static) IP Address.

Your PPPoE username provided by your ISP.
Your PPPoE password provided by your ISP.

Retype Password- Re-enterthe PPPoE password

Service Name-
IP Address-

Enter the Service Name provided by your ISP (optional).

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoE connection.

18



Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

Primary/Secondary Enter a DNS Address if you do not wish to use the one provided

DNS-

Maximum
Idle Time-

MTU-

Auto-reconnect-

LAN is short for Lo-
cal Area Network.
This is considered
your internal network.
These are the IP set-
tings of the LAN inter-
face for the DI-784.
These settings may
be referred to as Pri-
vate settings. You
may change the LAN
IP Address if needed.
The LAN IP Address
is private to your in-
ternal network and
cannot be seen on
the Internet.

IP Address-

Subnet Mask-

Local Domain
Name-

by your ISP. (DNS is short for Domain Name System. It trans-
lates domain names into IP Addresses).

Enter a maximum idle time during which Internet connection is
maintained during inactivity. To disable this feature, enter zero
or enable Auto-reconnect.

Maximum Transmission Unit-1472 is default-you may need to
change the MTU to conform with your ISP.

If enabled, the DI-784 will automatically connect to your ISP af-
ter your system is restarted or if the connection is dropped.

Home > LAN

D-Link

Building Networks for People

Air Pr‘emier:/\Gw

11a/11g Dualband Wireless 108Mbps Router

DI-784

| [ S Advanced  Tools Status Help
‘/,- LAN Settings
The IP address of the DI-784.
Wizard e —
IP Address 19216801 ‘
e Subnet Mask |255 256.265.0
Wireless : T -
Local Domain Name | | {optional)
(¥
prm— 9 OO

i Apply Cancel Help

DHCP

'

The IP Address of the LAN interface. The default IP Asddress is:
192.168.0.1.

The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0.

The domain name assigned to the router.

19



Using the Configuration Menu (continued)

DHCP stands for Home > DHCP

Dynamic Host =
Control Protocol. The Rg .;l;\;*l;l}&

DI-784 has a built-in

Ajr Pramier}\ Gl
J

11a/11g Dualband Wireless 108Mbps Router

DHCP server. The DI-784

DHCP Server will | [ - Advanced  Tools Status Help
aUtomat|CaIIy aSSIgn "’" :ﬂ‘we Ii]\—?"BA :-em be setup as a DHCP Senver to distribute IP addresses to the LAN
an IP Address to the network

computers on the DHCP Server ® Enabled O Disabled

LAN/private network. - Staring P Adiress 192,168 0 !&}

Be sure to set your f”d'”gT'_P Ak R\/ ﬂaf i [res

computers to be v sase fme ek

DHCP clients by
setting their TCP/IP
settings to “Obtain

Static DHCP is used to allow DHCP server to assign same IP to specific MAC address

O Enabled @ Disabled

dl

an |IP Address DHCP Narme [
Automatically.” When " wowo [ |
you turn your MAC Address ] 4 =)
computers on, they DHCP Client [winep 00-50-BAFFFF-FE v [Clone |
will automatically
load the proper TCP/ @ O 9
IP settings provided AppyConeel Hep
by the DI-784. The
DHCP Server WI” Host MName [P Address MAC Address
automatically
allocate an unused IP Dynamic DHCP Clent List

Host N IP Add WAL Addl E d Ti
Address from the IP AW 0100 COShRAErTETE | Masons 00017

Address pool to the
requesting computer.
You must specify the starting and ending address of the IP Address pool.

DHCP Server- Select Enabled or Disabled.

Starting

IP Address- The starting IP Address for the DHCP server’s IP assignment.
Ending

IP Address- The ending IP Address for the DHCP server’s IP assignment.
Lease Time- The length of time of the DHCP lease.

Static DHCP- Enable the Static DHCP server to assign the same IP Address

to a MAC Address that you specify here. This prevents the prob-
lems sometimes encountered with changing IP Addresses.
Static & Dynamic
DHCP Client Displays a list of Static and Dynamic DHCP clients assigned by

Table- the router. 20



Using the Configuration Menu (continued)

Advanced > Virtual Server

Building Networks for People

D-Link AjrPr amier}\Gw

11a/11g Dualband Wireless 108Mbps Router

DI-784 ;
I [ Home JWTITUTER Tools Status Help
Yirtual Server is used to allow Internet users access to LAM services.
Virtual Server
O Enabled O Disabled
Mame | |[ Clear]
Applications Private [P [
Protocaol Type i_TCP v]
Filters Private Port | |
Public Port | |
Firewall Schedule O Always
© Fram time |00 v |- |00 v|[AM v[10]00 | [00 v|[AM +]
(v
l_ =
Performance a J o
Virtual Servers List Apply Cancel Help
[Matre Private IP Protocal Schedule
Yirtual Server FTP 0.0.00 TCP 21421 always 4%
Yirtual Server HTTP 0.0.00 TCP 80/80 always Ei]
Yirtual Server HTTPS 0.0.00 TCP 4437443 abways 4%
Yirtual Server DNS 0.0.00 UDP 53/53 abways Ei]
Yirtual Server SMTP 0.0.00 TCP 25/25 always 4%
Yirtual Server POP3 0.0.00 TCP 1104110 always Ei]
Yirtual Server Telnet 0.0.00 TCP 23/23 always 4%l
IPSec 0.0.00 UDP 500400 abways [T
PPTP 0.0.00 TGP 17231723 abways 4%
Methieeting 0.0.00 TCP 17201720 abways [T

The DI-784 can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP Address can be automatically redirected to local
servers in the LAN (Local Area Network).

The DI-784 firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the DI-784 are invisible to the outside world.
If you wish, you can make some of the LAN computers accessible from the Internet
by enabling Virtual Server. Depending on the requested service, the DI-784 redirects
the external service request to the appropriate server within the LAN network.
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Using the Configuration Menu (continued)
Advanced > Virtual Server continued

The DI-784 is also capable of port-redirection meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular

virtual service.

Virtual Server- Select Enabled or Disabled.

Name- Enter the name referencing the virtual service.

Private IP- The server computer in the LAN (Local Area Network) that will be
providing the virtual services.

Protocol Type- The protocol used for the virtual service.

Private Port- The port number of the service used by the Private IP computer.

Public Port- The port number on the WAN (Wide Area Network)side that will

be used to access the virtual service.

Schedule- The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will
be disabled.

Example #1:

If you have a Web server that you wanted Internet users to access at all times, you
would need to enable it. Web (HTTP) server is on LAN (Local Area Network)
computer 192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server

Private IP: 192.168.0.25

Protocol Type: TCP

Private Port: 80

Public Port: 80

Schedule: always
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Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Servers List
MNarne Private IP Protocol schedule
B Virtual Server HTTP 192.168.0.25 TCP 804280 always ATl

| J' Click on this icon to edit the virtual service

." 1. Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 11:00PM, Sat to Sun

All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of
port redirection and can be useful in cases where there
are many of the same servers on the LAN network.
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Using the Configuration Menu (continued)

Advanced > Applications

Air Pr'r-:mler}.\( ;

11a/11g Dualband Wireless 108Mbps Router
DI-784

Spacial Application is used 10 run applications that require multiple connections.
L S—
S  Enabled ¥ Disabled

Narrur Clear |

i

Tngger Type | TCP =
Filters Public Part
Bubihe Ty ToF -
Firewall @ GA’ 0
P \ppelicabinm List Apply Cancel Help
e HMAME Trigger Pubdic
oMz Bttle net 6112 6112 i)
Dialpad 7175 51200-51201,51210 £l ]
e — e n 2018 2000.2038,2050-2051,2069,2085,3010-3020 35
Performance MSHN Garng Zone 47624 25002400, Y000 25
PO to-Phone 12053 12120,12123,24150- 24220 |
Quick Tame 4 554 6570-6999 ]

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties
working through NAT (Network Address Translation). Special Applications makes
some of these applications work with the DI-784. If you need to run applications that
require multiple connections, specify the port normally associated with an application
in the “Trigger Port” field, select the protocol type as TCP or UDP, then enter the
public ports associated with the trigger port to open them for inbound traffic.

The DI-784 provides some predefined applications in the table on the bottom of the
web page. Select the application you want to use and enable it.

Note! Only one PC can use each Special Application tunnel.

Name:

Trigger Port:

Trigger Type:
Public Port:

Public Type:

This is the name referencing the special application.

This is the port used to trigger the application. It can be either
a single port or a range of ports.

This is the protocol used to trigger the special application.

This is the port number on the WAN side that will be used to
access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

This is the protocol used for the special application.
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

Building Networks for Peaple

D-Link Air Premier:/-\G--

11a/119 Dualband Wireless 108Mbps Router

[ Home BT BR Tools Status Help

DI-784

Filters are used to allow or deny LAN users from accessing the Internet

I e ® IP Filters © URL Blocking
O MAC Filters © Domain Blocking

I

e —

Applications P Filters
Use IP Filters to deny LAN IP addresses access to the Internst

© Enabled O Disabled
®| -
" Firewall
P [ |
Protocaol Type |iC?_V

DMz Scheduls © Always

oy tme 00 ] [00 ] [A04 %] [00 ][00 ] [ ]

i

Performance day ’m‘ 1o ‘Suﬂ—\'l
@ 90
ter List Apply Cancel Help
IP Range Protocal Schedule
* TCP 2021 always ][]
- TCP 80 always [E{i]
i TCP 443 always i}
* UDP 53 always (T}
* TCP 25 always E{7]
- TCP 110 always [E{i]
% ICMP 8 always E{7]
* TCR23 always EiT}

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-784 can be setup to deny internal computers by their IP or MAC
addresses. The DI-784 can also block users from accessing restricted web sites.

IP Filters- Use IP Filters to deny LAN IP Addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP Address.

IP- The IP Address of the LAN computer that will be denied
access to the Internet.

Port- The single port or port range that will be denied access to the
Internet.

Protocol Types- Select the protocol type.

Schedule- This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu

Advanced > Filters > URL Blocking

D-Link

Building Networks for Peaple

Air PremierAC'~
3

11a/11g Dualband Wireless 108Mbps Router

DI-784 =
| [ Home BMWTYCLT BN Tools Status Help
‘,.’ Filters
Filters are used to allow or deny LAN users from accessing the Internet,
—_—
*Virtual Server O IP Filters & URL Blocking

O MAL Filters O Domain Blocking

——
Applications URL Blocking
Block those URLs which contain keywords listed below.

Filters O Enabled @ Disabled

F g i
Firewall

DMZ

9 90O
Apply Cancel Help
Performance

i

URL Blocking is used to deny LAN computers from accessing specific web sites. A
URL is a specially formatted text string that defines a location on the Internet. If any
part of the URL contains the blocked word, the site will not be accessible and the web

page will not display.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain the keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu

Advanced > Filters > MAC Filters

D-Link

Building Networks for People

Air Premiery\ -

11a/11g Dualband Wireless 108Mbps Router
DI-784
BT Advanced [ERTE Status Help
F\V\I‘era are used to allow or deny LAN users from accessing the Internet
R O IP Filters © URL Blacking

@ MAC Filters  Domain Blocking
—

Applications R e
Use MAC address to allow or deny computers access to the netwark
@ Disabled MAC Filters

O Only allow computers with MAC address listed helow to access the netwark
© Only deny computers with MAC address listed below to access the network

L]

" Firewall Narme | ‘
oz macaddess|  |-[ [ [ L[ [-[ ]
DHCP Client [m 000059436132 ]
p—
290

MAC Filter List Apply Cancel Help
Iame MAC Address

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Internet. You can either
manually add a MAC address or select the MAC address from the list of clients that
are currently connected to the Broadband Router.

Filters-

MAC Filters-

Name-

MAC Address-

DHCP Client-

Select the filter you wish to use; in this case, MAC filters was
chosen.

Choose to Disable MAC filters, or choose to allow or deny
MAC addresses listed below.

Enter the name here.

Enter the MAC Address of the client that will be allowed or de-
nied access.

Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu (continued)

Advanced > Filters > Domain Blocking

Building Networks for Paople

D-Link AjrPremierp
G
11a/11g Dualband Wireless 108Mbps Router

[ Home QYT Tools Status Help

DI-784

Filters are used to allow or deny LAN users from accessing the Intemet

VI ot ServeY © I Filters © URL Blocking
© MAC Filters @ Domain Blacking
P——

Applications Aeioes
Domain Blocking

® Disabled

O Allow users ta access all domains except "Blocked Damains”

© Deny users to access all domains except "Permitted Damaing”

Firewall i‘::' mains

008

mlc==
DMZ
P L
| &=

@ 90

Apply Cancel Help

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to a
specific domain such as http and ftp. It can also allow computers to access specific
sites and deny all other sites.

Filters-

Domain Blocking
Disabled-
Allow-

Deny-

Permitted
Domains-

Blocked Domains-

Select the filter you wish to use; in this case, Domain Blocking
was chosen.

Select Disabled to disable Domain Blocking.

Allows users to access all domains except Blocked Domains.
Denies users access to all domains except Permitted Domains.

Enter the Permitted Domains in this field.
Enter the Blocked Domains in this field.
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Using the Configuration Menu (continued)

Advanced > Firewall

D-Link

Building Networks for People

AirBPremier -
AG
11a/11g Dualband Wireless 108Mbps Router

[ Home ITTURYER Tools Status____Help

DI-784

™
i

|
£

Firewall Rules
Firewall Rules can be used to allow or deny trafiic from passing through the D784,

ey © Enabled © Disabled

N S —

O Allow O Deny
Interface  IP Range Start  IP Range End  Protocol  Port Range

- Source "‘ "” ” |
™ Fitters Destination [ 9] I [Tee @ I-[ 1]

Schedule O Always

O From nme‘-UU_"!:IE”W—"‘TD’UU_”‘ W@

 vr—
Applications Action

day_Sun *to|Sun ¥
’

DMZ @ Q0
Firewall Rules List Apply Cancel Help

JO— ActionMame SourceDestination Frotacol
Performance Allow Allow to Ping YWAN port WWAN *LAN 192.168.0.1  ICMP 3 £}
Alloy Memegs (19216B01008572) oy < an 192.168.0.100UDP B572-45281 [
Allow ;I;SWSQS (192.168.0.100:10120) WAN FLAN 152.166.0 muﬁ:ﬁggmm E]

Deny Default i3 LAMT IP

Allow Default LAN® = IP (@

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-784. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-784. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contains all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note: The DI-784 MAC Address filtering rules have precedence over the Firewall

Rules.
Firewall Rules-

Name-

Action-

Source-

Destination-

Schedule-

Enable or disable the Firewall Rules.

Enter a name for the rule.

Allow or deny IP traffic through the router.

Enter the IP Address range.

Enter the IP Address range, the Protocol,
and the Port Range.

Select Always or enter the Time.
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Using the Configuration Menu (continued)

Advanced > DMZ

Building Metworks for People

D-Link Ajr Premier*AGw

11a/11g Dualband Wireless 108Mbps Router

BT Advanced

DMZ
DOMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

P the Internet.
‘Virtual Server

Tools Status Help

) Enabled ® Disabled
IP Address 192 168.0./0 |

Applications

Filters Y OO

Apply Cancel Help

Firewall

Performance

A

If you have a client PC that cannot run Internet applications properly from behind the
DI-784, then you can set the client up to unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP Address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of
security risks, so only use this option as a last resort.

DMZ- Enable or disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the Internet.

IP Address- Enter the IP Address of the computer to be in the DMZ.
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Using the Configuration Menu (continued)

Advanced > Performance > 802.11a

Wireless
Performance- ; .
Select 802.11a or 802.11g. e A G
Here, 802.11a has been PSS | Y Advanced il Capiiadipas o
chosen. This screen displays . v . O %211a @E0211s
the Wi reless performance ‘(mu:m_a. Thase are the Wirsless Parformance festures for the AP{Azcess Paint) Fortion.
features of the Access Point ———

Applications

portion of the DI-784.

Data Rate-

Auto is the default selection.
Select from the drop down menu

for your selection.
Transmit Power-

Beacon interval-

RTS Threshold-

Fragmentation-

DTIM interval-

Authentication-
Open System -
Shared Key -

SSID Broadcast-

20~1000, default 100

default 2346)

Fragmentation - |2346 | fra 255~2345, defauh 2345, wven number only)

DT inkervai : 1 frange. 1-255, defaull 1)
Firewall SSI0 Broadcast . & Enabled O Disabled
Super A Mode * | Super Awith Dynamic Tutba +

Fullis the default selection. Select from the drop down menu for
your selection.

Beacons are packets sent by the DI-784 to synchronize a wire-
less network. Specify a value. 100 is the default setting and is
recommended.

This value should remain atits default setting of 2346. If incon-
sistent data flow is a problem, only a minor modification should
be made.

This value should also remain at its default setting of 2346. If you
experience a high packet error rate, you may slightly increase
your Fragmentation value within the range of 256-2346. Setting
the Fragmentation value too low may result in poor performance.

(Delivery Traffic Indication Message) 1 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Open system or Shared Key

The DI-784 will be visible to all devices on the network. This is
the default setting

In this mode, in order to access the DI-784 on the network, the
device must be listed in the MAC Address Control List

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.



Using the Configuration Menu (continued)

Super A Mode-

Disabled-

Super A without
Turbo-

Super A with
Dynamic Turbo-

Super A with
Static Turbo-

Wireless
Performance-

Advanced > Performance > 802.11a (Continued)

Super Aiis a group of performance enhancement features that
increase end user application throughput in an 802.11a network.
SuperAis backwarsd compatible to standard 802.11a devices.
For top performance, all wirelss devices on the network should
be super Acapable. Select either Disabled, Super Awithout Turbo,
Super Awith Dynamic Turbo, or Super A with Static Turbo.

Standard 802.11a support, no enhanced capabilities.

Capable of Packet Bursting, FastFrames, Compression, and no
Turbo mode.

Capable of Packet Bursting, FastFrames, Compression, and
Dynamic Turbo. This setting is backwards compatible with non-
Turbo (legacy) devices. Dynamic Turbo mode is only enabled
when all nodes on the wireless network is Super Awith Dynamic
Turbo enabled.

Capable of Packet Bursting, FastFrames, Compression, and
Static Turbo. This setting is not backwards compatible with non-
Turbo (legacy) devices. Static turbo mode is always on and is
only enabled when all nodes on the wireless network is Super A
with Static Turbo enabled.

Advanced > Performance > 802.11g

Select 802.11a or 802.11g.
802.11g is selected here. Dis-
played in this window are the
Wireless Performance fea-
tures for the Access Point por-
tion of the DI-784.

DI-784

[—
Wit Serve

applications

J—
Fillers

Firewall

TX Rates-

Auto is the default selec-
tion. Select from the drop
down menu for your selec-
tion.

{ EEEME--

Air PremierA —~
AG
11a/11q Duatband Wireless 108Mbps Router

& B0211g O 802 11e

These are tha Wirsless Parfomance foatures Sr the AR(ACcoss Peint) Portion

Transmit Power-

Beacon interval-

Full is the default selection. Select from the drop down menu for
your selection.

Beacons are packets sent by the DI-784 to synchronize a wire-
less network. Specify a value. 100 is the default setting and is
recommended.



Using the Configuration Menu (continued)

RTS Threshold-

Fragmentation-

DTIM interval-

Authentication-

Open System -
Shared Key -

SSID Broadcast-

Super G Mode-

Disabled-

Super G without
Turbo-

Super G with
Dynamic Turbo-

Super G with
Static Turbo-

Advanced > Performance > 802.11g (Continued)

This value should remain atits default setting of 2346. If incon-
sistent data flow is a problem, only a minor modification should
be made.

This value should also remain at its default setting of 2346. If you
experience a high packet error rate, you may slightly increase
your Fragmentation value within the range of 256-2346. Setting
the Fragmentation value too low may result in poor performance.

(Delivery Traffic Indication Message) 1 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Open system or Shared Key

The DI-784 will be visible to all devices on the network. This is
the default setting

In this mode, in order to access the DI-784 on the network, the
device must be listed in the MAC Address Control List

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwarsd compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should
be Super G capable. Select either Disabled, Super G without
Turbo, Super G with Dynamic Turbo, or Super G with Static Turbo.

Standard 802.11g support, no enhanced capabilities.

Capable of Packet Bursting, FastFrames, Compression, and no
Turbo mode.

Capable of Packet Bursting, FastFrames, Compression, and
Dynamic Turbo. This setting is backwards compatible with non-
Turbo (legacy) devices. Dynamic Turbo mode is only enabled
when all nodes on the wireless network is Super G with Dy-
namic Turbo enabled.

Capable of Packet Bursting, FastFrames, Compression, and
Static Turbo. This setting is not backwards compatible with non-
Turbo (legacy) devices. Static turbo mode is always on and is
only enabled when all nodes on the wireless network is Super G
with Static Turbo enabled. 33



Using the Configuration Menu (continued)
Advanced > Performance > 802.11g (continued)

CTS Mode-

802.11g only mode-

Administrator
Login Name-

user (lower case) is the default login name
for the user account. The user account has
read-only access to the router.

User
Login Name-

admin (lower case) is the default login
name for the admin account. The admin Acsty Cance Wl
account has read/write access to the

router.

Admin Password-

User Password-

CTS (Clear To Send) is a function used to minimize collisions
among wireless devices on a wireless local area network (LAN).
CTS will make sure the wireless network is clear before a wire-
less client attempts to send wireless data. Enabling CTS will
add overhead and may lower wireless throughput.

None- CTSistypically used in a pure 802.11g environment.
If CTS is setto “None” in a mixed mode environment
populated by 802.11b clients, wireless collisions may
occur frequently.

Always- CTS will always be used to make sure the wireless
LAN is clear before sending data.

Auto- CTS will monitor the wireless network and automati-
cally decide whether to implement CTS based on
the amount of traffic and collisions that occurs on
the wireless network.

Select this mode to restrict your network to only those devices
that employ the 802.11g standard. Enabling this mode will en-
sure that you maintain the highest connectivity rate, unhampered
by any connection to an 802.11b device.

Tools> Admin

Air Pr'-erniert\ +
A
11a/11g Dualband Wireless 108Mbps Router

DI-7B4
Home _ AdvancedBil "SR Status____Help |

Systom

ﬂﬂﬂﬂﬂ@t

The default setting is blank - no password. To change the pass-
word, enter and confirm the new password.

The default setting is blank - no password. To change the pass-
word, enter and confirm the new password. 34



Using the Configuration Menu (continued)

Tools> Admin (continued)

Remote Management

Remote Management allows the DI-784 to be configured from the Internet by a web
browser. A username and password is still required to access the Web-Management
interface. In general, only a member of your network can browse the built-in web pages
to perform “Administrator” tasks. This feature enables you to perform “Administrator”
tasks from the remote (Internet) host.

IP Address: Internet IP Address of the computer that has access to the Router. It is not
recommended that you set the IP Address to * (star), because this allows any Internet
IP Address to access the Router, which could resultin a loss of security for your network.
If you elect to enable Remote Management, make sure to enter the IP Address of the
remote computer allowed to configure the DI-784.

Port: For security purposes, select a separate port number used to access the Router.
(The following is an example only; you may use a different port number.)

Example: http://x.x.x.x:8080 where x.x.x.x is the WAN IP Address of the Router and

8080 is the port used for the Web-Management interface.

Tools > Time

Building Networks for People

D-Link Air Premiery

11a/11g Dualband Wireless 108Mbps Router

[__Home __ Advancefil " PN Status___Help

DI-784

‘/_,

Set the DI-784 system time

Local Time Apri01/2002 00:17:53

Tirne Zone ‘ (GMT-08:00) Pacific Time (US & Canada) b
Default NTP Server [ (cptional)

Setthe Ti [onne w
System BLNETMe  yoar[2002 ] mantn [Apr %] Day 01 ¥

e e ey -
Hour | 00 ¥ Minute | 17 ¥ Sacond |53 "E

Tim:

MBI

POSIEESS Daylight Saving S%ff&ﬁ’ﬁ?ifﬂzid [dan [¥][01 %]
' Misec.
9 00
Cable Test Apply Cﬁe‘ Help
Time settings- In this window you can choose the time zone; set the time;
and enable or disable Daylight Savings Time.
Default
NTP Server- NTP is short for Network Time Protocol. NTP synchronizes com-

puter clock times in a network of computers.
This field is optional.
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Using the Configuration Menu (continued)

Tools > System

D-Link Air Pr'emierAGw

Building Networks for People

11a/11g Dualband Wireless 108Mbps Router

[_Home __ Advanced CVTRR Status___ Help |

-

DI-784

System Settings

Save Settings To Local Hard Drive

Help

—
o
Load Settings From Local Hard Drive
| |[ Browse... |
System |
Fe——
Firmware .
Restore To Factory Default Settings
e —
Misc. o
-

System Settings

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive.

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load.

Restore to Factory
Default Settings- Click Restore to restore the factory default settings.
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Using the Configuration Menu (continued)

Tools > Firmware

D-Link AirPremiery

Building Networks for People

11a/11g Dualband Wireless 108Mbps Router

DI-784 -
| [CONR Status___Help |

-

Firmware Upgrade

There may be new firmware for your DI-784 to improve functionality and pedformance.
Click here to check for an upgrade on our suppart site.
To upgrade the firmware, locate the upgrade file on the local hard drive with the Browse
button. Once you have found the file to be used, click the Apply button below to star the
firmware upgrade.

Current Firmware Version: 0.01

Firmware Date: Tue, 18 Mar 2003

|[ Browse.. |

Firmware a Q 0

Apply Cancel Help

Misc.

' Cable Test

HE

Firmware

Upgrade- Click on the link in this screen to find out if there is an updated
firmware; if so, download the new firmware to your hard drive.

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart Device-
Block WAN Ping-

Discard Ping
from WAN side-

VPN
Pass Through-

DDNS-

Tools > Misc

Air F'r‘r—.'l"nier‘,\( =
LAy

1104119

— [__Home _ Advancedill (VTR Status___Help | DDNS-

e e Dynamic
Domain Name
System is a
method to

—_— keep domain

! names linked
to changing IP
Addresses. In
this way,
changing IP
Addresses
(e.g., via
DHCP) will not
interfere with
network
connectivity.

(-

The Ping Test is used to send Ping packets to test if a computer
is on the Internet. Enter the IP Address that you wish to Ping,
and click Ping.

Click Reboot to restart the DI-784.

If you choose to block WAN Ping, the WAN IP Address of the DI-
784 will not respond to pings. Blocking the Ping may provide
some extra security from hackers.

Click Enabled to block the WAN ping.

The DI-784 supports VPN (Virtual Private Network) pass-through
for both PPTP (Point-to-Point Tunneling Protocol) and IPSec (IP
Security). Once VPN pass-through is enabled, there is no need
to open up virtual services. Multiple VPN connections can be
made through the DI-784. This is useful when you have many
VPN clients on the LAN network.

PPTP- select Enabled or Disabled
IPSec- select Enabled or Disabled

Fill in the required fields to use the Dynamic Domain Name Ser-
vice (DDNS) feature. 38



Using the Configuration Menu (continued)

Tools > Cable Test

D-Link

Building Networks for People

Air Premier}\(ww
) §

11a/11g Dualband Wireless 108Mbps Router

DI-784 .

| Toos PR
CableTest I
Vfirtual Cable Tester (VCT)
Ports Link Status
Lant  T— T Connected
FUNE O A f
ane T L nected

{
:0

B
-]

Cable Test is an advanced feature that integrates a LAN cable tester on every
Ethernet port on the router. Through the graphical user interface (GUI), Cable Test
can be used to remotely diagnose and report cable faults such as opens, shorts,
swaps, and impedance mismatch. This feature significantly reduces service calls and
returns by allowing users to easily troubleshoot their cable connections.

Ports — The Ethernet port names associated to the physical ports.

Link Status — The current link status of the Ethernet cable connected to the respective
Ethernet port.

More Info — Click on More Info for detailed information about the cable link status.
Refresh — Click on Refresh to run the Cable test. Allow the router a few seconds to
complete the test.
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Using the Configuration Menu (continued)

Device Information- This screen displays information about the DI-784.

View Log-
Log Settings-

Status > Device Info

AirPre miery G
112/11g Dusiband Wirsless 108MBps Router
sons TN

Flmrmars Varsien: 0.01 , Tue, 18 Mar 2003

2
a
b

L
MAC Addowsn 0011 0304455
P Addewn 190 15201
Subaet Mk 155 255 2560

DICP Sarens Ensvied

1]

o
MAC Addvess 001122334458
CHCP Chirt Ditcsoractid
Camaacien [~ GHOP Faisase | | CHOF Flasew
P Addeem 0000

Subaet Mk 0000
Balah Giatrmny 0009
s

Wewless 102 119
MAC Addewmn (00326173855

W et
Chanss! |
WER Disabled

Wirmless 102 118
MAC Addemn (0100002434 61

B0 et
Chanme! 51 Torba Made: Diabind
WEF Disabied

o
=

Status > Log

Air Pr-ernier}\(—;-

11a/11g Dualband Wireless 108Mbps Router
Home __Advanced Tools [T L o |

Ly dhaplays fhe aciities accuming an the D78 Chck on Lag Seitings far advanca
featuen

FiitFage |[ LamFage T | [Gaar] [ LogSefings | Help

page | of 20
3 Tims Message SeurceDentinstisn Haln

AgfO1I2002 002402 Wareless PC connected O0-40.05-B7-56-8F
Ape01Z002 0024 01 DHCF Drscover
Aprf 12002 00 24 00 Wigelers FC connected 00-40.05-57-56-F
AprOLAE 0 23,58 Wirelers BC connected 00-40-05-B7-56-8F
ApriULZOUZ 023 4 Wireless BC connected 00-40.05-B7.56-EF
Apr1002 002352 Wireless PC connected 00-40.05-B7-56-8F
ApeLI2002 0023 52DHCE Discover
AprLA20G2 0023 50 Wireless PC connected Oh-40.05-57.56-8F
Aprf012002 0023 48 Wireless PC connected 00-40.05.57.56.8F
Ape1r002 0023 4EDHCE Ducover

This screen displays the activity on the DI-784.

For advanced features, click on Log Settings.
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Using the Configuration Menu (continued)

Status > Log > Log Settings
D-Link Air PremierAC'~
J

Building Networks for People

11a/11g Dualband Wireless 108Mbps Router

DI-784 . s
‘ Home  Advanced  Tools TR Help |
"" Log settings
Logs can be saved by sending it to an admin email address
—
Device Info

SMTP Server / P Address | |

Email Address [ |[_Send Mail Now
Log Type System Activity
[ Debug Information
Aftacks
E::r:ed Packets
9 00
Apply Cancel Help
SMTP Server/
IP Address- Enter the proper SMTP Server information or the IP Address.
Email Address- Enter the email address of the recipient who will receive the
email logs.
Log Type- The administrator can specify which surveillance they want to

log. Check mark the box for specific activities.
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Using the Configuration Menu (continued)

Status > Stats

D-Link Air Premiery -

Building Netwarks for People

11a/11g Dualband Wireless 108Mbps Router
DI-784 I —
Home  Advanced  Tools Status m

Traffic Statistics

Traffic Statistics display Receive and Transmit packets passing through the DF754

g

' Device Info o
Help
Receive Transmit
WAN 0 Packets 114 Packets
LAN 4769 Packets 5973 Packets
WIRELESS 11g 594 Packets 1013 Packets
WIRELESS 11a D Packets 1558 Packets

Wireless

=

Traffic Statistics- Displays the receive and transmit packets that are passing through
the DI-784. Click on Refresh, for the most recent information.
Click Reset to reset the counters back to zero.

Status > Wireless

D-Link

Building Netwarks for People

Air Premiery\CW
J

11a/11g Dualband Wireless 108Mbps Router

DI-784 =
| Home  Advanced  Tools COTE Help |
‘/‘ Connected Wireless Client List
The Wireless Client table below displays Wireless clients Connected to the AP o
m (Access Point) Help
Connected Time MAC Address Mode
April1/2002 00:25:24 00-40-05-B7-56-8F 2.4 GHz
[T April1£2002 00:23:06 00-90-4B-B0-FD-84 2.4 GHz
=
Connected
Wireless
Client List- Displays the wireless clients that are connected to the Access

Point function of the DI-784. 42



Using the Configuration Menu (continued)

Help

Building Networks for Peaple

D-Link Air F’r'arnier}\G'~

11a/11g Dualband Wireless 108Mbps Router
DI-784

Home  Advanced  Tools Status Help

‘/-- Home

« Setup Wizard
Menu « Wireless Settings
o WAN Settings
o LAN Settings
« DHCP Server

Advanced
« Vitual Server
« Special Applications
« Filters
« Firewall Rules
o DMZ
« Wireless Performance

Tools
« Administrator Settings
« System Time
« System Seftings

o Firmware Upgrade
« Miscellaneous ltems

Status
« Device Information
« Log
« Traffic Statistics
« Connected Wireless Client List

FAQs

Help- Displays the complete Help menu. For help at anytime, click
the Help tab in the Configuration menu.
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Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http.//www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help you set up this computer (o un on your
network. With a network, pou can:

Share an Internet connection

Set up Internet Connection Firewall
Share files and folders

Share a printer

LI R

To continue, click Mest.

[ Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Network Setup Wizand

Before you continue.__

Before you continue, review the thecklist for creating a netwark.

Then, complete the following steps:

+ Inztall the network cards, modems, and cables.

+ Tun on all computers, printerz, and external modems.
+ Connect ta the Intermet.

“When pou click Mest, the wizard will search for a shared Intermet connection on your network.

Click Next

In the following window, select the best description of your computer. If your
computer connects to the internet through a gateway/router, select the second option

as shown.

Network Setup Wizard
Select a connection method. %

Select the statement that best describes this computer:

() Thiz computer connects directly to the Intemnet. The other computers on my network connect
to the Internet through this computer,

Wiew an example.

@

is computer connects to the [ntemet through another computer on my network. or through
i

() Other

Learn miore about hame or small affice netwark confiqurations.

r—

< Back l Mewt > ' Cancel

Click Next
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Network Setup Wizard
Give this computer a description and name.

[Qomputer deszcriphion: Mary's Computer

—

Examples: Family Room Computer or Monica's Computer

[ Computer narme: Office ]
Evamples. FAMILT of MONICE

The current computer name iz Office

Learn mare about computer names and descriptions.

< Back l Mext = ' Cancel

Click Next

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Metwork Setup Wizand

MName your network.

Mame your netwark, by specifving a workgraup hame belaw. All computers on pour netwark,
should hawve the same work group name.

“Workgroup name: Accounting

Examples HOME or OFFICE

< Back Mext » Cancel

Click Next



Networking Basics

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network sethings. .

The wizard will apply the following settings. This pracess may take a few minutes to complate
and cannot be interupted.

Settings:
Metwork settings: A
Computer description: Mary's Computer
Computer name: Office
‘wiorkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
v

To apply these settings, click Mest.

’ < Back ﬂ Mest » i[ Cancel
\

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Hetwork Setup Wizard

Pleaze wait._.

Pleaze wait while the wizard configures thiz computer for home or small office networking, T his
process may take a few minutes.




Networking Basics

In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizard

You're almost done...

® - You need to run the Metwork Setup wizard once on each of the computers an your
J\:) network. To run the wizard on computers that are not running *Windows P, you can use
the Windows *P CD or a Metwork Setup Digk.

“w'hat do you want to da?

() Use the Netwark Setup Disk | alieady have
() Use my Windaws XF CD

(2 Just finish the wizard; | don't need ta run the wizard on other computers

(.

Insert a disk into the Floppy Disk drive, in this case drive A.

Network Setup Wizand

Inzert the disk you want to use.

Inzert a dizk the into the following dizk drive, and then click Next.
34 Floppy [4:]

If you want to format the disk. click Format Disk.

Format the disk if you wish, and click Next. 48



Networking Basics

Please wait while the Network Setup Wizard copies the files.

X]

Copying...

=~ LV

Please wait while the wizard copies files, ..

[ ) Zancel |

Please read the information under Here’s how in the screen below. After you com-
plete the Network Setup Wizard you will use the Network Setup Disk to run the
Network Setup Wizard once on each of the computers on your network. To continue
click Next.

Metwork Setup Wizand

To run the wizard with the Network Setup Disk_.. %

® . Complete the wizard and restart this computer. Then, uze the Metwork Setup Disk to run
\4) the Metwaork Setup Wizard ance on each of the other camputers an paur netwark.

Here's how:
1. Inzert the Metwork Setup Dizk into the nest computer you want to nebwark,

2. Open My Computer and then open the Metwork Setup Digk.
3 Double-chick "netzetup "
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Networking Basics

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Hetwork Setup Wizand

Completing the Network Setup
Wizard

You have successfully set up this computer for home or zmall
office networking.

For help with home or zmall office nebworking, zee the
fallowing topics in Help and Support Canter:

+ Uszing the Shared Documents folder
+ Sharing filez and folders

To zee other computars an your nebwaork, click Start, and then
click My Metwark Places.

To cloze thiz wizard, click Finizh.

< Back Finish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change |g|

P You must reskark your computer before the new settings will take effect.,
-

o

Do wou want ko restark your computer now?

I oves | [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Networking Basics
Naming your Computer

To name your computer, please follow these directions:In Windows XP:

m Click Start (in the lower left corner of the screen)

m Right-click on My Computer

m Select Properties and click

., Internet
g Internet Explorer
w5 E-mail

A Outlook Express

(X _Crmand Prompk

v 3N Explorer

® windows Media Player
@ Windows Movie Maker
@ Tour \Windows XP

ﬁ Files and Settings Transfer
“Wizard

_-_] My Documents
=1
43 My Recent Documents »

_f} My Pictures
]

-~} My Music
l My Computer
Open

l::l My Network  Explare
| Search...
G? Control Pane]  Manage
Map Metwork Drive. ..

e Connect Ta
=1

:é Printers and F

Disconnect Metwark Drive, ..

Show on Desktop
Rename

B Select the Computer
Name Tab in the System
Properties window.

B You may enter a Com-
puter Description if you
wish; this field is optional.

m Torename the computer
and join a domain, Click
Change.

System Properties

Remote
Advanced

tic Updates

System Rest
| Computer Hame ||

General | Hardware

-

>

Computer description: i

Windows uzes the following information to identify your computer
ot the netwark,

For example; "Fitchen Computer or "Mary's
Carnputer'.

Full computer name:  Office

Wwhark group: Accounting

To uzge the Metwork, Identification Wizard to join &
domain and create a local user account, click Metwork,

Torename this computer or join a domain, click Change.
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Networking Basics
Naming your Computer

B In this window, enter the Computer Name Changes

Computer name
Yaou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

B Select Workgroup and enter
the name of the Workgroup

Computer name:
Office
B All computers on your network _
Full computer name:
must have the same Office
Workgroup name.

More. ..

B Click OK tembier of.
() Domair

(=) whorkgroup:
Accounting

ox ) oo ]

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connection icon

in the task bar Repair

Wiew Awailable Wireless Metworks

Open MNetwork Connections
B Click on Status
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Networking Basics
Checking the IP Address in Windows XP

Wireless Network Connection 7 Status |E||z|

General |i Support .

This window will appear.

Internet Pratocal [TCPAAF)

| Click the
Support tab Address Type: Agzzigned by DHCP
| 1P addess 1921680114 |
Subret Mazk: 255.255.255.0
Default Gateway: 132168.0.1

[ | Click Close

Close

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Ad-
dresses to the computers on the network, using DHCP (Dynamic Host Configura-
tion Protocol) technology. If you are using a DHCP-capable Gateway/Router you
will not need to assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP
Address, please follow these instructions:

| E-’ Control Panel

u Go to Start @ Tour Windows P

‘g Paink

y | Files and Settings Transfer
. - Wiizard
B Double-click on ,-) Search

Control Panel

|::é1 Printers and Faxes

g) Help and Suppart

All Programs D E Run...

ﬁ| Lag off |6| Turn OFF Camputer




Networking Basics
Assigning a Static IP Address in Windows XP/2000

B Control Panel

File Edit View Favarites Tools Help
% —
d Back (<>} ﬁ /'_) Search [Ff Faolders v
Address [} Control Panel
= 7%, Accessibility Options
u’ Control Panel L dd Herdware
. D bl I k ;Q;Add ar Remove Programs
ouple-Click on [} Switch ko Cakegory Yisw A Administrative Tools
Network —# Date and Time
Connections See Alsa
ﬂ eSS 7 Game Controllers
@) Help and Support Plnkernet Options
Phone and Modem Options
Sy Power Options
aPrinters and Faxes
e Regional and Language Options
= Scanners and Cameras
‘) 5cheduled Tasks
) Sounds and Audio Devices
[r—
‘g Start,
" Network Connections
File Edt View Favorites Tools  Advanced  Help
Qo - O - [F| O search [ Fokders
& Network Connections
A Mame
Network Tasks § LAN or High-Speed Internet
[ Create anew
connection Disable
. . % Setupah il Stat
B Right-click on Local Area e puotus
H @ Dissble this network _—
Connections s Brdge Connectins
S - [
8, Repair this cornection Croate it
B[} Rename this connection Delete
& view status of this Rename

connection
Change settings of this
connection

B Double-click on
Pro perties Other Places

@ Control Panel b
\_} My Netwark Places

(L) My Documents

i My Computer

Details
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Networking Basics
Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

B Click Properties

B Select Use the following
IP address in the Internet
Protocol (TCP/IP)
Properties window (shown
below)

H [Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
of 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The
subnet mask must be the
same for all the computers
on the network.

B Enterthe IP Address
of the Default
Gateway (in this case
it is 192.168.0.1 for
the DI-784)

B Input your DNS server
address.

-L Local Area Connection 7 Properties

EE3

General | Advanced

Connect using:

E  D-Link DWL-AE50

This connection uzes the following items:

Igl, Clignt for Microzoft Metworks

S File and Printer Sharing for Microzoft Networks
B 05 Packet Scheduler
Intn;emet Pratocol [TCF/IF] l

[ escription

Tranzmizzion Contral Protocaol/|ntermet Protocol. The default
wide area network, protocol that provides communication
aciogs diverse inkerconnected networks.

[ Show icon in notifization area when connected

Ok ] [ Cancel

Internet Protocol (TCP/IP) Properties E]E|

General

“fou can get IP settings assigned autarnatically if your netwark supparts
this capability. Otherwize, pou need to ask your network, adrinistrator for
the appropriate [P zettings.

(C) Obtain an IP address automatically
(G) Use the following IP address )

P address:

192168 0 . 2
Subnet mask: 255,286 . 286 0

Default gateway:

(@ Usze the following DMS server addresses:)

Preferred DNS server

192 168, 0 . 1

]

Alternate DMS server

The DNS server address will be supplied by your ISP (Internet Service Provider).
Ifthe DNS Server address is not available from your ISP, you may input 192.168.0.1

in this field.
B Click OK
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Networking Basics

Assigning a Static IP Address with Macintosh OSX

B Go to the Apple Menu and se-
lect System Preferences

B Click on Network

B Select Built-in Ethernet in the
Show pull-down menu

m Select Manually in the
Configure pull-down menu

B Inputthe Static IP Address,
the Subnet Mask and the
Router IP Address in the
appropriate fields

B Input the Domain Name
Server address. Your ISP
(Internet Service Provider)
will provide the IP address of
the DNS Server. If the DNS
Server address is not avail-
able from your ISP, you may
input 192.168.0.1 in this field.

B Click Apply Now

[X:) =
= & z
ERERO®B"
s R v od 2
Intereet & Metworkh
(&) Q @
Syvem
LIS N

‘e e Nerwark [=]

« 0@ O

Show All  Duplays Sound Network  Startug Disk

Location:  Automatic [ia )

Show: _Bult-in Ethernet _________F)

DHCP Router

Configure  Lising DHCP

Using BootP

IP Address
(Provided by DHCP Serven

Subnet Mask: 255.255.255.0

Router: 192.168.0.1

DHCP Cliens 1D
(Opcionaly
Lample: agple.com. sasthlinknet
Ethernet Address.

(@) Click the lock to prevent further changes.

‘88 Nerwark =

« = A A =

Show All  Duplays Sound Network Startup Disk

Location: Automatic .E-‘
Show: | Bullt-in Ethernet  T¥)

Freepe eevoe | appletalk | praxies |

Confiqure: | Manually H

Domain Name Servers iOptionall

Subnet Mask:  255.255.255.0

Router:  192.168.0.1 Sirch Donates——ted

Lnample: agale.com. earthlinknet
Ethernet Address. 00.09.93.75.de5a

‘W) Click the lock 1o prevent further changes.




Networking Basics
Selecting a Dynamic IP Address with Macintosh OSX

an
kB0 8
B Go to the Apple Menu and select mn | E @B e & @
System Preferences s
S8 s =md 9
B Click on Network i) g a @
88 Network

« mAa@ O
Show Al Deiplays Sound Network  Startup Desk

Bl Select Built-in Ethernet in the

Location: | Automatic 5
Show pull-down menu evow: [ Bolicin BTt B
:i I"."“"'”\" = * £ L ]

+ Using DHCP

B  Select Using DHCP in the
Configure pull-down menu B T -

Submet Mask. 255.255.255.0

0

Router: 19216801 Search Domains __ toptionsh
DHCP Client ID:
Qateanall
BT Frample apple.com, rashlisk net
@ Chick the lnck to prevent further changes. App Now
eo MNetwork
« =A@ 3
. Show All Dhtplays  Scund Network Startup Disk
. CIICk Apply Now Location: | Automatic i3 )
Shaw: | Built-in Ethernet 3]
= fTCPIFY Preoe Y AppisTalk | Prowies |
. (s B
B The IP Address, Subnet Confgure: (wbponey
Pl Domain Name Servers iOgtianali
mask, and the Router’s IP e BETh
(Provaded by DHCF Serven
Address WIII appear In a feW Subnet Mask 255.255.255.0
seconds S Starch Domains__ opaony
DHCP Client 1D
IDprisnal)
Ethernet Address: 00.06.96.79.de 5a oottt berblviogin
(&) Chck the lock to prevent further changes  Apply Now




Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m GotoStart>Run > BEE
type cmd. A window et e i o B
Similar tO th|S one [F:\Documents and Settings\lab4>ping 192.168.8.58

ill T Pinging 192.168.0.50 with 32 hytes of data:
Wi appear' ype Rewly fron 192.168.0.50: hyt

A cply £rom :
ping Fonly Fron 175.165.0.58:

XXX.XXX.XXX.XXX, o prseistics tor L g msn:
where xxx is the IP ST R LN FRAL R
Address of the IP:\Documents and Settings\lah4>_
Wireless Router or
Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start> Run
> type command.
A window similar to
this will appear.
Type ping
XXX XXX XXX. XXX
where xxx is the IP ST
Address of the S
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-784 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Note: Itis recommended that you use an Ethernet connection to
configure the DI-784 Wireless Broadband Router.

1.The computer used to configure the DI-784 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-784 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that
the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-784. Please see Checking the IP Address in Windows XP in the
Networking Basics section of this manual.

Note: The IP Address of the DI-784 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do a Ping test to make sure that the DI-784 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. Asuccessful
ping will show four replies.

‘ et EAWINDOWS\System32vcmd.exe HEH

Note: If you have changed
the default IP Address,
make sure to ping the cor-
rect IP Address assigned
to the DI-784.

0s A (Bx loss>,
ds :

Bns
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Disable The followaing network[z) are available. To access a network, select

Status
Repair

it from the list. and then click Connect.

Available networks:

i alan ~

8]

Wigw Available Wirelass Networks dan
pen Hetwork Comnections _v
T |
.l

If you are having difficulty connecting ta a netwark, click Advanced.

[ Connect l[ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within the

same IP Address range as the access point and gateway. (Since the DI-
784 has an IP Address of 192.168.0.1, wireless adapters must have an

IP Address in the same range, e.g., 192.168.0.x. Each device must have
a unique IP Address; no two devices may have the same IP Address.

The subnet mask must be the same for all the computers on the
network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

If it is necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.

B Select the
Hardware
Tab

B Click Device
Manager

i", Windows Media Player I
Open

Explore

B’ Control P Search...

Manage
e Conneck
5]

|:é Printers 2

Map Metwork Drive, .,
Disconnect Metwork Drive. .

v Show on Desktop

@) Help and  Rename
I.) Search

All Programs D

Turn COff Computer

' start

System Properties

| System Restore || Automatic Updates Femate

| General || Computer Mame I Hardware I Advanced

Add Hardware Wizard
§ The Add Hardware “Wizard helps you install hardware,

Add Hardware Wizard

Device M anager

The Device Manager lists all the hardware devices installed
on pour computer, Use the Device Manager to change the
properties of any device.

——
’ Diriver Signing ] [( Device Manager 3 ]

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

[ Hardware Profiles ]

ak l[ Cancel ] Apply




Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPro DWL-A650
Wireless Cardbus
Adapter (In this example,
the DWL-A650 is used;
you may be using another
network adapter, but the
procedure will remain the
same.)

B Select Properties
to check that the
drivers are
installed properly

B Look under Device
Status to check that the
device is working

properly

B Click OK

Z¢ Device Manager

File  Action Wew Help
& 2

= &, prTEST
+ ﬁ Eatteries
+- ¢ Computer
+- g Disk drives
+ fé Display adapters
+-i=) Flappy disk contrallers
+ ﬂ, Floppy disk drives
+- (=) IDE ATAIATAPT contrallers
+-2» Keyboards
¥ '_')' WMice and other pointing devices
5
0

R_,, Modems

s Cardbus Adapker

§ PCMCIA adapters
5 Parts (COM & LPT)
% Processors
@, sound, video and game controllers

System devices
Universal Serial Bus controllers

][] [ [ [

| General | Advanced | Seftings | Driver || Resouses|

[r-Link AiPro DWL-AE50 Wireless Cardbus Adapter

Device bype: Metwork adapters

Marufacturer: D-Link |

| |
Location: PCl busz 5, device 0, function 0

|
Device status |
|
|

This device is working properly.

| If you are having problems with thiz device, click Troubleshoot to
shart the troubleshooter.

Troubleshoot. ..

Device uzage:

Use thiz device [enable] |




Troubleshooting

4. What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-784. Try to
keep the antenna at least 6 inches away from the wall or other objects.

B Ifyou are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

To establish a wireless connection, while enabling Encryption on the DI-784, you must
also enable encryption on the wireless client.

B For 802.11a, the Encryption settings are: 64, 128 or 152 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B For 802.11g, the Encryption settings are: 64, 128, or 152 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

Make sure that the SSID on the Router and the Wireless Client are exactly the same. If
they are not, wireless connection will not be established. Please note that there are two
separate SSIDs for 802.11a and 802.11g. The default SSID for both 802.11a and 802.11g
is default.
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Troubleshooting

7. Resetting the DI-784 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-784 to the factory default settings. Remember that D-Link
Air Premier AG products network together, out of the box, at the factory default
settings.

To hard-reset the D-Link Air Premier AG DI-784 to Factory Default Settings, please do
the following:

B Locate the Reset button on the back of the DI-784.
B Use a paper clip to press the Reset button.

B Hold for about 10 seconds and then release.

B After the DI-784 reboots (this may take a few minutes) it will
be reset to the factory Default settings.
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Technical Specifications

Standards:
[ |

IEEE 802.11g
IEEE 802.11b
IEEE 802.11a
IEEE 802.3 and IEEE 802.3u

VPN Pass Through/Multi-Sessions:

PPTP
L2TP
IPSec

Advanced Firewall Features:

Supports NAT with VPN pass-through, for added security
MAC Filtering

IP Filtering

URL Filtering

Domain Blocking

Scheduling

Device Management:

Web-based -Internet Explorer v6 or later; Netscape Navigator
v6 or later; or other Java-enabled browsers
DHCP Server and Client

Wireless Data Rates with Automatic Fallback:

D-Link 108 AG 108Mbps
54Mbps
48Mbps
36Mbps
24Mbps
18Mbps
12Mbps
11Mbps
9Mbps
6Mbps
5.5Mbps
2Mbps
1Mbps
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Technical Specifications (continued)

Security:
|
[ |

64-, 128-, 152-WEP
WPA -Wi-Fi Protected Access (WEP with TKIP, MIC, IV
Expansion, Shared Key Authentication)

Media Access Control:

CSMA/CAwith ACK

Wireless Frequency Range:

2.400GHz to 2.500GHz
5.150GHz to 5.850GHz

Wireless Operating Range:

Indoors: Up to 328 feet (100 meters)

Modulation Technology:

Orthogonal Frequency Division Multiplexing (OFDM)
Complementary Code Keying (CCK)

Receiver Sensitivity:

54Mbps OFDM, 10% PER,-73dBm
48Mbps OFDM, 10% PER,-76dBm
36Mbps OFDM, 10% PER,-82dBm
24Mbps OFDM, 10% PER,-85dBm
18Mbps OFDM, 10% PER,-88dBm

12Mbps OFDM, 10% PER,-89dBm
11Mbps CCK, 8% PER,-91dBm

9Mbps OFDM, 10% PER,-90dBm
6Mbps OFDM, 10% PER,-91dBm
5.5Mbps CCK, 8% PER,-92dBm
2Mbps QPSK, 8% PER,-93dBm
1Mbps BPSK, 8% PER,-94dBm
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Technical Specifications (continued)

Wireless Transmit Power:
[ ] 15dBm * 2dB

LEDs:

Power

Status

WAN

WLAN (Wireless Connection) - 802.11a, 802.11g
Local Network (Ports 1-4)

External Antenna Type:
| Single Non-Detachable Antenna

Operating Temperature:
| 32°F to 131°F (0°C to 55°C)

Humidity:

[ | 95% maximum (non-condensing)
Power Input:

[ | Ext. Power Supply DC 5V, 3.0A

[ | 100-240V~50-60Hz

Safety and Emissions:
[ | FCC

Dimensions:
[ | L = 7.56 inches (192mm)
u W = 4.65 inches (118mm)
u H = 1.22 inches (31mm)

Weight:
[ | 10.8 oz. (0.3kg)

Warranty:
[ | 3 years
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-784 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in
to a ROM chip in the device itself. Your computer must be on the same IP subnet to
connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. o 1 White-Green
define the wiring standards and allow for g ‘(’;_J;..tan o
two different wiring color codes as 1 Blue e
illustrated in the following diagram. g ggig;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere.

1 White-Orange
H Il straight-through cable f 3 inge
ow to tell straight-through cable from I White-Green
. 4 Blue
acrossover cable: _ 5 Whie.Blue
The main way to tell the difference 6 Green
: ¥ White-Brown
between the two cable types is to compare 8 Brown

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

[imimirt oot &if7]
Step 3 Configure you internet settings. ey
® = O 9
|
Go to Start>Settings>Control Panel. Double click P |
the Internet Options Icon. From the Security tab, T
click the button to restore the settings to their T e
defaults. 0l
g gt
(o] o | v
armms| Socusty | Fiacy | Covters. Corvmcions | Pagrams | advarces |
& .
Click to the Connection tab and set the dial- e
up option to Never Dial a Connection. Click SRR —
the LAN Settings button. 2.8
e

r
Ll e b LA

e
LA g s e sk b e oo L e
e Somng ses s A v —TJ

Nothing should be checked. Click OK.

Go to the Advanced tab and click the
button to restore these settings to their
defaults.

Click OK. Go to the desktop and close any open
windows.




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range as the device you are attempting to configure. Most D-Link devices use the
192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run

Type the name of a program, folder, or document, and
‘windows will open it for you.

Open: Iwinipcfg j

0k i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

m IP Configuration M=

~Ethernet Adapter Information

Adapter Addiess D[k, DFE-SB0T, 107100 Adapter

IP Address 0.0.0.0
Subnet Mask 0.0.0.0
Default Gateway

ak I Eeleaze, | Femen |

Release All | Renew All | HMore Info >> |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.

Run @ s

oL Twpe the name of a program, folder, document, or
Internet resource, and Windows will open it For wou,

Qpen: [ cmd |

[ Ol ]I Cancel II Browse, .. ]

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway.

[5] D\, WINNT sy stem32',CMD.EXE

Microsoft Windows 280A [Uersion S.ﬁ 21951
{C» Copyright 1985-2888 Microsoft Corp.

D:~>ipconfig

Windows 2088@ IP Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

TP AAAPESS. o « = & o v = o = - u : 192.168.8.174
Subnet Mask = 255.255.255.8

Default Gateway : 192_168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | assign a Static IP Address in Windows XP?

Step 1

Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007?
Step 1 Right-click on My Network

e 5 pew Fgetm Lok Aduged i

. bk - o - (| o &% X o IO
Places and select Properties. e T —
>0 & 0 %
Step 2 Right-click on the Local Network and Dial-up  coreeen Coris

Connections

Area Connection which represents
your network card and select

-
Properties.
21
Connect using:
I B D-Link DFE-530T PCI Fast Ethernet Adapter
Corfigue
Components checked are used by this connection:
i i File and Printer Sharing for Microselt Netwarks =]
Highlight Internet Protocol (TCP/ o :
. . (TCP/IP]
IP) and click Properties. | | j
4 »
Install Uninsial | Fuopaties |
-~ Diescription
Transmission Control ProtocolIntemet Protocol. The default
wide area network pratocol that provides communication
acrost diverse interconnected networks.
¥ Show icon in taskbar when connected
0K Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007?

(continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose is
not in use on the network.

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Set the Primary DNS to be the same as
the LAN IP Address of your router
(192.168.0.1).

Internet Protocol (TCP/IP) Propetties 2ixl
General
You can get |P settings assigned automatically if wour network. supports
this capability. Dthenwise, you need to ask your netwark administrator for
the appropriate |F settings.
" Obtain an IP address autamatically
—(* Uge the following IP address, ————————————————————————
1P address: 192 168. 0 . EG
Subret mazk: 265 255 .265 . 0
Default gateway 192 168. 0 1
£ Obtain DNS server address automatically
—{* Use the following DNS server addresses———————————————
Preferred DMS server. 192 168. 0 1
Altemate DMS server: 4 2 2 2
Cancel

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding” for
each adapter. Highlight TCP/IP > (your
network adapter) and then click
Properties.

Network 2] %]
Cenfiguation | dentfication | Aceess Contil |

The following network components are installed

Client for Microsoft Metworks
D-Link DFE-530T> PCI Fast Etheret Adapter (Fev 4]

Add. | Pemove | Fuoperies |

Primary Network Logan:

[ Client for Microsoft Metworks |
File and Print Sharing...
Description
TCPAR is the protocal you use to connect to the Intemet and
wide-area networks
Carcr
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows
98/Me? (continued) T ——
| wedios ]

Step 2 Click Specify an IP Address. i P P e By

e o . .
1 ina rwsbwaca. s vt smstcamaticy i P kchmsons, ik
the 1pace below,

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.

1 Dibtain an P addbess sutomeficaly

Example: If the router’s LAN IP Address is =
192.168.0.1, make your IP Address IPadbess
192.168.0.X where X is between 2-99. Make Epnt

sure that the number you choose is not in
use on the network.

Ok I Cancel

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router e | et | _mus

here (192.168.0.1). e e ————

Click Add when finished. o

s

Step 4 Click on the DNS Configuration tab. - oo

Click Enable DNS. Type in a Host (can be

any word). Under DNS server search order,

enter the LAN IP Address of your router Lo ] oo |
(192.168.0.1). Click Add.

T Y ]
Hidings [] Advrced | Hebis
mww Gty | WIS Configrion | 1P fuldhass
Step 5 Click OK twice. e
When prompted to reboot your computer, Hot [ o
click Yes. e o] L
After you reboot, the computer will now have e (B

a static, private IP Address. .

—

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in x| o |
the address bar. This should open the login page for the web

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IEATNT-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). Enter Network Password 2]
.? Flease lype your user name and password.

Step 2 Click the Home tab and click the T s 15216301

WAN button. Dynamic IP Address is the Resn  DI84

default value, however, if Dynamic IP Address UsesName  [sdmin

is not selected as the WAN type, select Bossword [

Dynamic IP Address by clicking on the radio ™ Save this passmond n yea passmond

button. Click Clone Mac Address. Click on Concel_|

Apply and then Continue to save the

changes.

Building Networks for People

D-Link Air F’r‘ernier}\(;w

11a/11g Dualband Wireless 108Mbps Router

DI-784
| [T Advanced  Tools Status Help
Please select the appropriate option to connect to your ISP,
——
Wizard
@ Dynamic IP Address Choose this option to obtain an [P address automatically
from your ISP. (For most Cable modem users)
T Wireless O Static IP Address Choaose this option to set static IP information provided to
you by your ISP
© PPPoE Choosge this option if your ISP uses PPPoE. (For most
DSL users)
WAN © Others PPTF and BigPaond Cable
O PPTP (for Europe use only)
—
LAN
Host Mame |D\-7?4 |(nptmna|j
P e e —
DHCP HATAES: oo [ -frv ]-fee |[s3 ][44 ] [56 optionan
Clone MAC Address
Primary DNS Address (000 ]
Secondary DNS Address .D oon | (optional)
MTU [1500 |
@ 90
Apply Cancel Help




Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.*
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by

L 2
typing in the IP Address of the router P o
(default:192.168.0.1) in your web browser. The (i se o
username is admin (all lowercase) and the password Rean O
. . B
is blank (nothing). o ——

™ Save this password in your password st
Step 2 Click the Home tab and click the WAN Crcn |

button. Select Static IP Address and enter your static
settings obtained from the ISP in
the fields provided.

D-Lin

Buflsting Hetwerks fze Foepln

Air F'r':—?:r'nier:_\(—‘-
If you do not know your settings, 17 ot Wielss 088ips Bown,

you must contact your ISP.

DI-784

.
i
—

Wircless

[T, TS Advanced ool Status Help

Please select the appeopriate option to your ISP
Wiz

card =

© Dynamic 1P Addrass utomaticslly

)

@ Statiz IP Addess

O PPPeE

Step 3 Click on Apply and then
click Continue to save the
changes.

1

© Cahers

1 Addross (111 {asigned by your ISF)

oo Subret Mash, 1000

LE

Step 4 Click the Status tab and
click the Device Info button. Your ““T‘mm :::: o

IP Address information will be Wy 1500
displayed under the WAN heading. 9 90

Apply Cancel Help

ISP Gateway Address nooo
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

and enter the IP Address of
your D-Link router

“irtual Server is used to allow Internet users access to LAN services.

@ Enabled © Disabled

(192.168.0.1). Enter username Narne [pcanywheral Claar
(admin) and your password Private IP 192.168.0.100
(blank by default). Protocal Type  [UDP =]
Private Port 22
Step 2 Click on Advanced on PubicPot [
top and then click Virtual Sehedule & Atways
Server on the left side. € From tirne [0 ] - [00 =] [AM =] 1 [00 =] - [0 =] [AM =]
dayISun - thSun 'I

Step 3 Check Enabled to

activate entry.
Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.

80



Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDMZ

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).

81




Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based

configuration of the router by typing in the IP p=
Address of the router (default:192.168.0.1) in tﬁﬁ
your web browser. The username is admin R
(all lowercase) and the password is blank
(nothing) Access Poink
User name: ﬂ adrr_}in |
Password: [
[CIremember my password
Step 3 Click the Advanced tab and then | T

click on the DMZ button. Select Enable and
type in the IP Address you found in step 1.

D-Link

Building Networks for Peaple

Air Premieq\c-~
3

Step 4 CIICk Apply 11a/11q Dualband Wireless 108Mbps Router

and then Continue

DI-784 .
to save the changes. BTN Advanced [PTIE Status Help

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Intermet

Note: When DMZ is
enabled, Virtual
Server settings will
still be effective.
Remember, you e %
cannot forward the - 9 99
same port to multiple
IP Addresses, so the
Virtual Server
settings will take
priority over DMZ [ —

settings.

“Virtual Server
© Enabled & Disabled

IP Address 1921880 [0 |

Applications

Apply Cancel Help

Firewall

[l EIEA--
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Frequently Asked Questions (continued)

How do | open a range of ports on my router using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.
Step 3 Clickon

Enabled and type in
a name for the new

D-Link

Building Networks for Peaple

Aijr Pr%miex‘?\(w~
¥

11a/11g Dualband Wireless 108Mbps Router

DI-784

rule. | [ Home JWEVLTVEE Tools Status Help
step 4 ChOOSG WAN ‘/. ;in:;wal\ Rulé‘arc‘an be used to allow or deny traffic from passing through the DI-784
as the Source and VeliolServer

© Enabled O Disabled

e | 1=

enter a range of IP

ns Cction
Addresses OUt on the iaiii o Igerg‘:ew _\_(p)ﬂzi;!ye: Start _IF‘ Par!_g_e End  Protocol Port Range
internet that you soce [+ ¥ | [
would like this rule s {; ] | e @ 1]
. Schedule Always
applied to. If you — O From tims 00 ] (00 ] [ 4M 11000 %] [00 ][t ]

would like this rule to
allow all internet
users to be able to

day (Sn_ 1o [Bun ]

9 00

es Li Apply Cancel Help
Actioniame SourceDestination Pratacol

L O

access these ports, Performance Allow Allow to Ping WAN port WANLAN192.168.0.1 [CMP 8 [4
then put an Asterisk Allow T8 (192163 01008572)  \yap = an 192 168.0.100UDP 57245281 [
in the first box and Al 1588 (52 ABBOIINNT) v an 192 sa 0,100 502" 3
leave the second box Deny Defaul LA P @

Allow Default LAN® ** P ).
empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 83



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN

server at 192.168.0.7, then you need to specify the following virtual server mapping

serverpot | Servertp | Enable

table:

21
80
1723

192.168.0.5 X
192.168.0.6 X
192.168.0.7 X

How do | use PC Anywhere with my router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP is
the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 Thefirstentry
will read as shown here:

Step 5 Click Apply

and then click Continue.

Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.

& Enabled  Disabled

Mame [pcanywhere M
Private IP IW
Protocol Type ITP;,
Private Part |22—
Public Port 22
Schedule & Always
€ From time [00 x| - [00 7| [AM > o [00 =] - [00 7| [AM =]
day [Sun =] to[Sun =]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my router? (continued)

Step 6 Create
a second entry

as shown here:

Step 7 Click
Apply and then

click Continue.

Step 8 Create
a third and final
entry as shown

here:

Wirtual Server is used to allow Internet users access to LAN services.

% Enahled © Disabled

Mame |pcanywher82 Clear |
Private |P |1 52.168.0.100

Protocal Type ITCP 'l
Private Port |5531
Public Port I5831

Schedule & Always

 From timelﬂuj:|DDﬂIAMﬂtD|UDﬂ:|DDﬂIAMﬂ

day ISun 'l mISun 'I

Yirtual Server is used to allow Intermet users access to LAN services.

& Enabled © Disahled

harne IpcanwhereS Clear |
Private P |192.1EB.D.1DD

Protocal Type IUDP 'l
Private Part |5832
Public Paort |5632

Schedule & Always

© From time |00 x) - [00 =] |AaM =] to |00 =] - [00 =] |AM =]

day ISun 'l to ISun 'l

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address.
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Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
Step 3 Create a new firewall rule:

Click Enabled.
Enter a name

(edonkey).
Click Allow. AjrPremierp -
Next to Source, A
select WAN under 113/11g Dualband Wireless 108Mbps Router
i . DI-784
interface. In the first P | o asvane ETET—
box, enter an *. Leave . ———— - -
the Second box Firewall Rules can be used to allow or deny traffic from passing through the DI-784
empty. M Iver © Enabled O Disabled

i i MName edonkey 7|
Next to Destination, o ol

select LAN under
interface. Enter the IP
Address of the
computer you are
running eDonkey

Interface  IP Range Statt 1P Range End  Protocol  Port Range
Sowce  [wAN¥[* [ |
Destination |LAN [ 192.168.0100 | [+ lfasen - [ae55]
Schedule O Always

O Fom tme[8018] .00 ] 00 9] 00 1. (109 [0 9]

day S 1S ]

Filters

B

from. Leave the DMz 2 00
] i Apply Cancel Hel
Second bOX empty' ActionMame SourceDestination grnymcglnc =
Under Protocol, Allow Allow to Ping WAN port WANTLAN 19216801 ICMP B E}
select *. In the port ; Allow =8 (192163 0100:8572)  \yap = any 192 168.0.100UDP 867245281 [4

msmsgs (192.168.0.100:10120) TCP 10120- @
7 [

range boxes, enter g 730
4661 in the first box Bt B Tae
and then 4665 in the
second box. Click

Always or set a schedule.
Step 4 Click Apply and then Continue. 86
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 2?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the |IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

Air Prer‘nier}\(i-

11a/11g Dualband Wireless 108Mbps Router

DI-784
1 home ITETOR oo st Hoo |

‘.- - Wirtual Server is used to allow Intemet users access to LAN seraces
Achost b ® Enabled O Oisabled
Mame socom [Gear]
Abpiasons Prvale [P 192.168.0.100
Puatacol Type  Both ™
S Fillars Friaate Fot | 6869
Public Port 6869
Fieewell Schudul ® snways
O From time |00 3| |00 )| AM /1o |00 %) |00 %1 AM 3

day|Sun M o [ Sun

HED

Apply Cancel Help
Prervate P Protocel Schedule

0000 TCP 2121 ahways 41
0000 TCP B0 shears )]
0000 TCP d03a3 ahwys e
0000 UDP53S3 aways 40
0000  TCR252S sways [
0000 TP 1IGNI0 swags LA
oooo TR swaygs (A5
0000  UDPS00500 shways i}
FRTP 0000 TCRITINTA  ahaps ]
NatMesting aooo TCRITONT0 whways 4t

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 87



Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser
and enter the IP Address of the
router (192.168.0.1). Enter
admin for the username and
your password (blank by
default).

Step 2 Click on the Advanced
tab and then click Virtual Server
on the left side.

Step 3 You will create 2
entries.

Step 4 Click Enabled and enter
Settings:
NAME - Gamespy1

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783

SCHEDULE - Always.
Click Apply and then continue

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy2

PRIVATE IP - The IP
Address of your computer
that youare running
Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.
Click Apply and then continue.

Air Premier‘.\
A
11af11g Dualband Wireless 10&Mbps Router

“irtual Server is used 1o allow Intemet usars access o LAN sanices
® Enabled O Disabled
Mame gamespy1 [Geer]
Prrale IP 192.168.0.100
Pratacal Type | TCE
Fricate Fot | 37831
Public Port 3783
Schedul & Aways
O From time 00 3| |00 3| | AM 1o |00 3 |00 %) | AM 3

day|Sun M o [ Sun

LS Apply Cancel Help
Name Pervate [P Protocel Schedule

Vinual Seeeer FTP 0000 TeP 21 ahways Al
Virtusl Server HTTP 0oon TCP B ahways 2] ]
Virtual Server HTTPS oono TCP 443843 shways F1]
Virtyal Sereer DNS 0000 UDP 5353 ahways i
Virtyal Sevar SMTP 0000 TCR 2505 ahways =i
Virtyal Seeer POPY anon TEP 11010 always 5
wirtusal Soeer Tolnst onoo TCP 2373 abways F) ]
PS5t ooon LDF S00/S00 ahways £l ]
FRTP onon TCR 177ANT - 4
KetMeating 0000 TCP 1720720 ahways 4

AirPr emier}\
¥
11a/11g Dualband Wireless 10&Mbps Router

Wirtual Server is used to allow Intemet users access to LAN seraces

® Enabled O Disabled
Name gamespy2 (Geet]
Prreale IP 192.168.0.100
Puatacel Type  Both ™

Prinate Pat 6500
Public Port 6500
Sehedule ® Anways

O From time |00 2[00 %[ AM /o 00 - 00 ! [am

day|Sun M o [ Sun

LS Apply Cancel Help
Name Pervate [P Protocel Schedule

intual Seecer FTP 0.000 TCP 2121 ahways Al
Virtusl Server HTTP 0oon TCP B ahways 2] ]
irtual Server HITPS [T TP J03843 aways 30
Virtual Server DNS 0000 UDP 5353 ahways Bl
irtual Sereur SMTP 0000 TCP 2505 aways 30
itual Sarenr POPI o000 TEP HONID sways 3
itisal Saorenr Talrst a0o0o TCP 2323 aways 30
PS5t ooon LDF S00/S00 ahways £l ]
PRTR anno TCR 1TTNTA ahways ]
Nethesiing Q000 TCP 17204720 ahways 4t

Qo
oo




Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

[ __Home JWEVCUTURN Tools  Status  Help

K .
(N L] i

Wirual Semver is usad to allow Internet users access to LAN serices

& Enabled © Digabled
Mame |kuzua Claar

Private IP lm
Protocol Type m
Private Port W
Fublic Port W
Schedule & Always
= From time [00 =] - [00 =] [a0 =] 10|00 =] - [00 =] [am =]
sy [0 =] 1o [Sm =]

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624, DI-754, DI-764, or DI-784:
Step 1 Open your web browser
and enter the IP Address of your

router (192.168.0.1). Enter
username (admin) and your

AirPr ea-nier',\(. -
LAy

11a/11g Dualband Wireless 108Mbps Router

password (leave blank). ‘] [_Home EWEWTUNEN Tools  Status  Help |
- Wirtizal Server is used to allow Intemet u access to LAN seraces

Step 2 Click on Advanced Iﬂ ® Enabiss O Dissbied
and then click Virtual Server. e e =

Patacei Type Both
Step 3 Create a new entry: gl T
Click Enabled. Enter a name Soude @ v
(warcraft3). Private IP - Enter O e
the IP Address of the computer :
you want to host the game. rutemancs . 2, c;"f’,,.,. 2,
Select Both for Protocol Type TR e
Enter 6112 for both Private Port Bi10 heia e BN
and Public Port Click Always or 8000 Tou® e BN
set a schedule. it o gl

N M e

Step 4 Click Apply and then Lt e

Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
h.323 software packages.

The solution is to put the router in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new
firewall rule:

Click Enabled.
Enter a name
(ichat1).

Click Allow.

Next to Source,
select WAN under
interface.

In the first box,
enter an *.

Leave the second
box empty.

Next to Destination,
select LAN under
interface.

Enter the IP
Address of the
computer you are
running iChat from.

D-Link

Building Networks for Peaple

DI-784

|

| —
[~ |

DMZ
=

Virtual Server

Applications

" Filters

Performance

Air Pr‘ernier:/\Gw

11a/11g Dualband Wireless 108Mbps Router

[ Home BWY-TUUEE Tools

Firewall Rules can be used to allow or deny traffic from passing through the DI-784

Status Help

@ Enabled O Disabled

Name fichat1 | [Crear]

Action ® Allow O Deny
Interface  IP Range Start 1P Range End  Protocol  Port Range

Source  |WAN ¥ [ I |
Destination LAN +[192.168.0.100 || [UDP~[se0].[ |
Schedule @& Always

© From sims [00 %] [00 ] A #1000 ][00 ][ ]

o
day [Sun_ ¥ ta[Sun v
9 00
irewall Rules Apply Cancel Help
ActionMame SourceDestination Protocol
Aliow Miow to Ping WAN port WA TLAN 192 1601 ICMP A ]
Allow o8 (192163 01008572)  \yap = an 192 168.0.100UDP B572-45281 [4

mamsgs (192.168.0.100:10120) TCP 10120-

Allow 17 WAAN FLAN 192 168.0 10017539 ]
Deny Default *FOLANY 1P )"
Allow Default LAN = 27 P @)

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,

enter 5060 in the first
box and leave the
second box empty.

Click Always or set a
schedule.

Step 4 Click Apply
and then Continue.

Step 5

Repeat steps 3 and 4
enter ichat2 and open
ports 16384-16403

(UDP).

D-Link

Building Networks for Peaple

DI-784

Virtual Server

Applications

" Filters

0 EH

DMZ

Performance

[

Air Premier‘AGw

113/11g Dualband Wireless 108Mbps Router

[ Home BWYTTLNEE Tools

Firewall Rules can be used to allow or deny traffic fram passing through the DI-784

Status Help

@ Enabled O Disabled

Marme ichat2 |

Action ® Allow © Deny

Interface  IP Range Start IP Range End  Protocol  Port Range
Source  [WAN ¥ I
Destination [LAN ~[192.168.0.100 ||
Schedule @& Always

O From tima |00 % - |00 | [AM 1o |00 | [00 %] [am ]

[[UDP]tese4] - 16403]

==
day [5in 1o [Sun ¥]
9 00
irewall Rules Apply Cancel Help
ActionMame SourceDestination Protocal

WWAN TLAN 192.168.0.1  ICMP 8 E]
WWAN TLAN,192,168.0.100UDP 8572-45281 [4

Al Allow to Ping WAN port

msmsgs (192.163.0.100:8572)
Al 152

L (192.168.0.100:10120)

i TCP10120- >
WWAN TLAN 192 168.0 1DD17539 I_‘?
Deny Default T LANS P o>

Allgw Default LA ™" L
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on Advanced and ]?-Link "Air Premier A
then Virtual Server. Building Networks for Peaple ] G
11a/11g Dualband Wireless 108Mbps Router
Step 2 Check Enabled to T | e ssvnced SRRSO
activate entry. .- Vil Ser
Wirtual Server is used to allow Intemet users access to LAN serdces
| ntoesictod | @ Enabled O Disabled
Step 3 Enter a name for your —— Nams ichat3 [Gear]
virtual server entry (ichat3). — i
5190
Step 4 Next to Private IP, enter 51%
the IP Address of the computer S R R R
on your local network that you oy S0 10 Sun
want to allow the incoming 990
service to. 0 Aspiy Cance Help
Nams Prervate P Protocel Schedule

0.000 TCP 2121 ahways Al
Step 5 Select TCP for Protocol e ;;-_j::f;gjj” oo :j_;i
Type. 2000 Tomm  wen G

aona TCR 11010 alwiys 7} ]

oong TCP 2323 abwiys ) |
Step 6 Enter 5190 next to Gits  mpaked  aom BN
Private Port and Public Port. Hathlesling 0noD  ToP TN a:w:s E]

Step 7 Click Always or
configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.
Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Each NAT box has a
table consisting of pairs of local IP Addresses and globally unique addresses, by
which the box can “translate” the local IP Addresses to global address and vice versa.
Simply put, it is a method of connecting multiple computers to the Internet (or any
other IP network) using one IP Address.

D-Link’s broadband routers support NAT. With proper configuration, multiple users can
access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
» Model number or product name

» Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) Three (3) Years
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

. After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do notinclude any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the
property of D-Link. Products shall be fully insured by the customer. D-Link will not be held
responsible for any packages that are lost in transit to D-Link. The repaired or replaced
packages will be shipped to the customer via UPS Ground or any common carrier selected by
D-Link, with shipping charges prepaid. Expedited shipping is available if shipping charges are
prepaid by the customer and upon request.

Return Merchandise Ship-To Address
USA 17595 Mt. Herrmann, Fountain Valley, CA, 92708
Canada: 2180 Winston Park Drive, Oakville, ON L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEAND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.
. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized
modifications to this equipment; such modifications could void the user’s authority to operate the
equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. The antenna(s) used for this equipment must be installed to provide a separation
distance of at least eight inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ ]
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